
USER MANUAL



Special Thanks

DIRECTION

Frederic Brun Pierre-Lin Laneyrie

ENGINEERING

Samuel Limier

Mathieu Nocenti

Michel Davit

Benjamin Renard

Valentin Lepetit

Germain Marzin

Matthieu Courouble

DESIGN

Morgan Perrier Sébastien Rochard

MANUAL

Morgan Perrier Randy Lee

© ARTURIA SA – 2017 – All rights reserved.
11 Chemin de la Dhuy
38240 Meylan
FRANCE
https://www.arturia.com

Information contained in this manual is subject to change without notice and does not
represent a commitment on the part of Arturia. The software described in this manual is
provided under the terms of a license agreement or non-disclosure agreement. The software
license agreement specifies the terms and conditions for its lawful use. No part of this
manual may be reproduced or transmitted in any form or by any purpose other than
purchaser’s personal use, without the express written permission of ARTURIA S.A.

All other products, logos or company names quoted in this manual are trademarks or
registered trademarks of their respective owners.

Product version: 1.0

Revision date: 21 June 2017

https://www.arturia.com


Thank you for choosing Arturia!

This manual covers the features and operation of Arturia’s MIDI Control Center, the
companion software for many Arturia hardware devices. For additional information about
the hardware itself, please read the appropriate owner's manual.



Introduction

Dear musician,

The fact that you're reading this manual means that you have done your research and
have purchased one of our products. Thank you! We like to think that you did so having
recognized the power, flexibility, and sheer fun of the Arturia device you now own. We are
certain you are about to begin a journey that will lead to the production of some amazing
music.

This manual will help you make the most of your Arturia product by using the MIDI Control
Center, the powerful companion software we designed to work with our hardware.

The MIDI Control Center does much more than simply give you another way to tweak
the front panel controls of the device; it also provides access to parameters that are not
available from the front panel.

If you are reading this manual and have not already downloaded the MIDI Control Center,
you can find it here: Arturia Downloads.

 ♪: A pop-up window will let you know when a new version of the MIDI Control Center is available.

You'll have the option to update at that time or wait until later.

Be sure to visit the www.arturia.com website for information about all of our great hardware
and software instruments. They have proven time and again to be the go-to solutions for
musicians around the world.

Musically yours,

The Arturia team

https://www.arturia.com/support/updates&manuals
https://www.arturia.com
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1. WELCOME TO THE MIDI CONTROL CENTER!

Arturia has a long history of developing highly sought-after hardware products, while also
crafting supplementary software that enhances the capabilities of the hardware many
times over.

The MIDI Control Center (MCC) is software with many faces, but one purpose: to unlock the
full potential of the device with which it is being used. The MCC is constantly evolving and
growing; as each new hardware device is released, its virtual partner is added to the list of
supported devices inside the MCC window.

The MCC supplies an additional way to configure the front panel features of a device, and
also provides access to features that are not available directly on the physical unit. The
software and hardware are a powerful combination, and in your hands a creative trinity will
be unleashed!

1.1. Features of the MIDI Control Center

 ♪: The following list is not exhaustive. Not all features are available on all devices. Please refer to the

appropriate documentation for specific information.

• Device settings

◦ Memory backup

◦ Response curves

◦ Sequence/pattern behavior

◦ MCU/HUI control

◦ Transposition

◦ CV/Gate characteristics

◦ Sync settings

◦ Drum map

◦ User scale

◦ Import/export settings to/from another unit

• Performance control assignments

◦ Faders, knobs, modulation wheel

◦ MIDI Channel number

◦ CC/RPN/NRPN number and range

◦ Aftertouch and range

◦ Bank/Program number and range

◦ Pitch Bend MIDI channel

◦ Pads, buttons, switches

◦ MIDI Machine Control

◦ Preset selection/MIDI Program change

◦ MIDI note number

◦ MIDI CC toggle

◦ LED color

◦ Sustain Pedal operation

2 Arturia - User Manual MIDI Control Center - Welcome to the MIDI Control Center!



• Sequences/patterns

◦ Pattern length

◦ Step size

◦ Notes

◦ Duration/Gate time

◦ Tie/Hold

◦ Legato

◦ Swing amount

◦ Scale selection

• Keyboard

◦ Zone MIDI Channel

◦ Split point
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2. OVERVIEW

2.1. The Main window

The Main window of the MIDI Control Center shows information related to the device(s) you
have connected. For example, you may see one or more of these items on the right side:

• an image of the device: this enables you to assign MIDI messages to many of
the controls.

• a grid or a musical staff for creating and editing a sequence or pattern.

• two or more tabs within the window for access to different features.

• a button that leads to the global settings of the device.

In other words, the right side of the window contains most of the device-specific functions.
We'll give general information about these things elsewhere in this manual, but for full
descriptions of these features you will need to refer to the appropriate documentation.

However, the left side of the main window is fairly uniform from one product to the next. It
is these shared functions which will be described in this chapter of the manual.

2.1.1. Device selection

Connect one or more Arturia devices to your computer and then launch the MIDI Control
Center. Next, locate the Device menu in the upper left corner of the MCC. Click anywhere in
the Device Name field to open the selection menu.

Your device(s) will be in the list of connected devices:

The device which is currently selected has a blue check mark by its name. To use the MCC
with a different device, select its name within the Connected Device list.

Device selection menu
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2.1.2. Sync

The Sync button is located immediately to the right of the Device selection window, as
shown below.

For those devices that support Sync mode, clicking this button will pull the contents of their
memory into the MCC for editing.

For more information about Sync and non-Sync operations, see the chapter Working with
Templates [p.10].

2.1.3. Firmware Revision

The MCC will notify you of firmware updates for the connected device if your computer is
connected to the internet. Firmware update notifications will look something like this:

There is more information about device firmware updates in the chapter Updates [p.22].

Firmware update
notification
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2.1.4. Device Memories / Device Projects

The left side of the MCC window shows a list containing Memories, Projects, and Templates,
depending on the connected device. When one of these items is selected from the list the
MCC can transmit that item to, or request that item from, the internal memory of the device.
The Store To / Recall From buttons are used for this purpose. See Working with Templates
[p.10] for information about this.

 ♪: Some products such as the MatrixBrute have their project management features on the right side

of the MCC window, not the left side. Please refer to the product documentation for more information.

Here are some examples of what you may see, depending on the selected device:

The items within these windows may be dragged and placed into new locations to re-order
or overwrite existing data.

Some Arturia products, such as the BeatStep Pro, do not utilize a Working Memory or a
Working Project. In that case the Device Projects list and Project Browser window may look
like this:

The memory management techniques for both sync- and non-sync devices are detailed in
Working with Templates [p.10].

The Device Memories Device Projects -syncable
devices-

The Device Memories /
Device Projects windows

-non-sync devices-
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2.1.5. Template utility buttons

Beneath the Project Browser window are a series of buttons that are used to save, create,
and share your original Templates.

The functions of the Template utility buttons are discussed in greater length in Working with
Templates [p.10].

2.1.6. Resizing the window

To see a larger number of the Projects in the Device Projects list, click and drag the window
resizing button:

2.1.7. MIDI Console

When the MCC and your device are connected it is possible to monitor the MIDI messages
sent by and to your device. To do so, select MIDI Console in the View menu (or use Ctrl/Cmd
+ M).

A panel will open at the bottom of the MCC to display the MIDI data in both hexadecimal
and "friendly" formats. This window also allows text selection and copy.

Resizing the Device
Projects window

The MIDI Console window

Arturia - User Manual MIDI Control Center - Overview 7



2.2. The basics of editing

2.2.1. Selecting a control

Many devices have a page inside the MCC that shows a graphic representation of their front
panels. This enables you to construct a Controller Map for that device.

A Controller Map contains a set of MIDI assignments for the available knobs, pads, buttons
and controls. Hover over the desired control, or click it; if it is assignable it will turn red and
a list of its editable parameters will appear at the bottom of the MCC window.

More information can be found in the chapter Controller Maps [p.20].

2.2.2. Setting values

There are two main ways to enter new parameter values in the MIDI Control Center: click
something and move it, or type a number into a field.

In many cases both options are available. For example, if you want to change the Swing %
value for a pattern, there are two methods:

• Click and drag the knob graphic, or

• Double-click in the value field and enter a new value.

To edit a parameter that has multiple options in a list, click its pull-down menu and make a
selection:

MiniLab Controller Map: Pad 1 selected

Editing a knob value

Selecting a pull-down
menu option
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2.2.3. Selecting the tabs

The middle window of the MIDI Control Center often has tabs. For example, when used
with a BeatStep Pro there are six tabs: Project, Seq1, Seq2, Drum, ControllerMap, and Device
Settings.

In the picture above, ControllerMap is the active tab. Simply click on a tab to select its
window.

Please refer to the appropriate manual if more information is needed about editing the
parameters of a particular device.

The device tabs: BeatStep Pro shown
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3. WORKING WITH TEMPLATES

3.1. The Sync button

 ♪: Some Arturia devices do not support the Sync feature. Here is a partial list of devices that do or

don't:

- Sync supported: BeatStep, KeyStep, KeyLab series

- Sync not supported: BeatStepPro, DrumBrute, Spark, MiniLab series

Clicking the Sync button is a quick way to back up the data from your device. It also allows
you to do other things we’ll cover later in this chapter.

However, there are some things you can do even if you don’t click the Sync button. Here’s a
quick overview of the different states:

3.1.1. Sync operations

The MIDI Control Center (MCC) does the following when you click the Sync button. Not all
features are available on all devices:

• It automatically makes a backup copy of the internal memory of your device.
This is known as a Template.

• It allows live editing of parameters from within the MCC window. See the
appropriate manual to learn more about how to use this feature with your device.

 !: When the MCC and a device are synced, every time you click on a Template in the Project Browser

window it will be sent to the internal memory of the device. Any changes you have made from the front

panel of the device will be lost.
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3.1.2. Non-sync operations

When the MCC and the device are not synced there are plenty of features available.
Depending on the device you are using, the MCC will allow you to:

• drag and drop a pattern or sequence from the Project Browser to one of the Bank
tabs

• send a single pattern to the internal memory of the device

• use the Store To and Recall From buttons to transmit an entire memory bank in
either direction

• edit the Device Settings

• perform other MCC functions such as pattern editing, file management and
Template creation, etc.

 ♪: The MCC will also perform all of the functions listed above when the MCC and the device are

synced.

3.2. Definitions: Memories, Projects, and Templates

The MCC window will show "Memories" for some devices and "Projects" for others. So before
we dive into the rest of this chapter let's define those terms:

• Memories contain the MIDI assignments for each control and each pad, and
may also contain pattern data for sequences, arpeggios or drum patterns,
depending on the device. Many of our keyboard products offer multiple
Memories, so it may be helpful to think of Memories as "presets."

• Projects are similar to Memories but contain more different types of data. For
example, a Project in the BeatStep Pro contains the data for 2 step sequencers
and 1 drum sequencer, in addition to the MIDI assignments for each control. It
may be helpful to think of Projects as "songs."

• A Template contains the same data as a Memory or a Project, so whichever type
you will be working with, that's what a Template is. All devices save their User
data as Templates in the Project Browser.

3.2.1. The Project tab

With some devices you will see a "Project" tab on the right side of the MCC window. This
contains settings that do the following within a Template:

1. They affect the entire set of patterns or sequences

2. They define basic parameters such as keyboard split point, MIDI Channel, and
response curves, etc.

The settings contained by the Project tab are stored with the Template, so they are sent to
the device when the Store To function is used, and transmitted by the device when the Recall
From function is used.

 ♪: The Device Settings tab contains parameters that are not stored with the Template. They are saved

and recalled independently using the Import/Export buttons found on the Device Settings tab. For more

information about this process, see Device Settings [p.18].
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3.3. Project / Template Browser

The Project / Template Browser shows a list of all the Templates that have been archived
onto your computer using the MIDI Control Center. These are divided into two main groups:
Factory and User.

A Template often contains the same number of items as the internal memory of the device,
and it also has them arranged in the same way: for example, four banks of 16 patterns, or
whatever is appropriate for your device.

However, some devices can hold multiple Templates at one time. Examples include the
KeyLab series keyboards (10 Templates, or Memories) and the BeatStep Pro (16 Templates,
or Projects).

 ♪: A Template does not contain the Device Settings. We’ll show you how to save those separately in

Device Settings [p.18].

3.3.1. Device Templates

A Template may contain one or more layers and types of data, depending on the device.
If additional levels are available, they may be revealed and hidden using the "+" and "-"
symbols in the browser window.

Examples of types of Templates: click +/- to expand or collapse Template view

3.3.2. Building a library

You can build a limitless library of data from your device in the User Templates area.

Make as many presets, patterns, or sequences as you like, wherever you are. Then the next
time you use the MIDI Control Center, simply press the Recall From button. This will transfer
the device memory into the MCC.

The MCC will create a new Template in the User Templates area. The Template will be named
automatically with a date/time stamp, but you can give it a more descriptive name if you
like.

12 Arturia - User Manual MIDI Control Center - Working with templates



3.3.3. The Working Memory / Working Project

 ♪: Some Arturia products do not have the Sync feature, and others do not have a Working Memory

or Working Project. Please refer to the documentation for specific information about your device.

When the MCC and a device are in sync, the Working Memory is also the active memory of
the device. Edits made to most parameters and performance data inside the MCC are made
simultaneously to the device.

When they are not in sync the Working Memory functions as a sort of ‘target’ onto which
Templates, sequences, or patterns can be dragged and then transmitted to the device
memory. But edits made inside the MCC when not in sync do not edit the data inside the
device.

Here are some examples of the Working Memory / Working Project from various products:

Examples of the Working Memory / Working Project

3.3.3.1. Live editing

If your device is sync-capable, then after you click the Sync button the internal memory
from the device will be displayed inside the MCC. Any edits you make to this data will also
be made in the device. This is called “live editing.”

 !: Live editing works in one direction: from the MCC to the device. Changes made from the front

panel of the device are not detected by the MCC. Use the Recall From button to back them up to your

computer before selecting another Template.

When you make a change in the Editor window an asterisk (*) will appear next to the name
of the selected Template. These changes are not automatically saved, so you will need to
use the Save or Save As... buttons to preserve your new data.
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3.3.3.2. Drag and drop

It’s possible to drag a single item or an entire Template from the Project Browser onto the
Working Memory. When you do, the data will be sent to the device internal memory.

Here's another example of how a sub-component of a Project, in this case the Controller
Map, can be dragged from within the Project Browser and dropped onto any one of the
Projects:

Drag and drop one item
from within a Template

Drag and drop a
Controller Map onto a
Project within a device
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3.3.4. Revise a Template

3.3.4.1. While synced

If the MIDI Control Center and the device are already in sync, it’s easy to modify an
archived Template. Simply select one and its data will appear in the Editor window. This data
will also be transmitted to the device internal memory.

As long as the device and the MCC are in sync, any changes made to the data inside the
MCC will also be made in the device. If the device is pattern-based you can actually have
the pattern running inside the device while you make edits with the MCC, and then hear the
edited pattern the next time the pattern loops.

 ♪: When an edit is made an asterisk will appear next to the name of the source Template. This means

you need to use the Save or Save As... buttons to preserve your new data.

See the documentation for your device to learn about editing patterns or sequences in the
MCC.

3.3.4.2. Not synced

If the MIDI Control Center and the device are not in sync you can still edit the data of an
archived Template. Simply select that Template and its data will appear in the MCC Editor
window, ready to be edited.

If you would like to confirm the results by having the data played on the device, there are
two ways.

 !: The following process will overwrite the Working Memory and the pattern memory of the device.

Be sure to save what you were doing before you transfer the file!

First use the Save or Save As... buttons to save your changes, then:

• drag the revised Template from the Local Templates window and drop it on the
Working Memory, or

• press the Store To button (see the next section).
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3.4. Store To / Recall From

3.4.1. The ‘Store To’ button

The upper left-hand section of the MIDI Control Center has a button called “Store To”. It
is used to transmit a Template from the Local Templates / Project Browser window to the
device.

 !: The following process will overwrite the internal memory of the device. If you are not sure the data

has been backed up, be sure to archive it to your computer using the Recall From button.

If there is a particular Template you would like to transmit to your device, select it in the
Local Templates / Project Browser window.

If the device and the MCC have been synced, all data from the Template will be transmitted
to your device as soon as you select the Template.

But if the device and the MCC have not been synced, or if your device does not use the sync
feature, you will need to use the Store To button to transmit the Template.

The process is similar to the one described previously:

• Select the desired Template as shown below

• Click the Store To button in the middle of the window.

This process will store all of the data from the selected Template into the device.

3.4.2. Recall edited data from the device

If you changed any data inside the device you need to pull it into the MIDI Control Center to
preserve it. To do that, click the Recall From button. A new file containing all of the data from
the device will appear in the Local Templates window with the current time/date stamp for
a name. You can rename it if you like.
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3.4.3. Template utilities

Beneath the Project Browser window are a series of buttons that are used to save, create,
and share your original Templates.

3.4.3.1. Save/Save As…

Use these buttons to preserve an edited Template or make a duplicate as a backup. These
files will appear in the Project Browser window in alphabetical order.

3.4.3.2. New/Delete

Create a new Template from the default settings with the New button. Use the Delete button
to discard an unwanted Template, and it will be removed from the Project Browser window.

3.4.3.3. Import/Export

Use these buttons to swap Templates with other users. This will generate a file with the
name of the product as an extension; i.e., a Template for the BeatStep will have the extension
.beatstep.

 ♪: The Template Utility Import/Export buttons do not perform the same functions as the Import/

Export buttons under the Device Settings tab. The functions of those buttons are described in Device

Settings [p.18].
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4. DEVICE SETTINGS

4.1. The Device Settings tab

When a device is connected, the MIDI Control Center will automatically pull the settings for
that device into the computer. To view the Device Settings for the connected device, select
this tab.

 ♪: There may be more parameters than can fit in the window at one time, so use the scroll bar on

the right side of the window to access them all.

Device Settings are also sometimes called "Global parameters". Examples of Device Settings
include:

• Clock in/out settings

• CV/Gate settings

• Tap Tempo on/off

• Global tempo

• Metronome on/off

• User Channel

• MIDI Thru enable

• Keyboard split point

• Pedal Mode / Function

• Velocity / Aftertouch curves

The options are different for each parameter, so please refer to the appropriate manual if
additional information is needed.

 ♪: When a new value is selected for one of the Device Settings parameters in the MCC, that change

will be made inside the device at the same time. There is no need to transmit anything to the device; it

has already been done.
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4.2. Import/Export Device Settings

When the Device Settings tab is selected you will see two buttons below the tab labeled
Import and Export. The function of these buttons is to manage files containing only the
Device Settings. They are different from the Template utility Import/Export buttons, which
are used to generate a file containing both the Project Tab settings and the Template data.
Those buttons are described in greater detail in Working with Templates [p.10].

The Device Settings files have an extension related to the product name. In other words,
for the DrumBrute the extension will be .drumbrute_ds. You can swap these files with other
users or build a library of configurations for the different systems you encounter.

4.2.1. Export Device Settings

To export the Device Settings, click the Export button. Then navigate to the appropriate
location in your computer and follow the prompts to save the Device Settings file.

4.2.2. Import Device Settings

To import the Device Settings, click the Import button. Then navigate to the appropriate
location in your computer and follow the prompts to load in the Device Settings file.

When the Device Settings file is imported into the MIDI Control Center it is also sent to the
device at the same time.

Please refer to the appropriate manual if more information is needed about the settings for
a particular device.
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5. CONTROLLER MAPS

A Controller Map contains a set of MIDI assignments for the configurable knobs, pads,
buttons and other controls a device may have, including pedals. There are many different
types of data that may be transmitted, depending on the control:

• MIDI Continuous Controller values (modulation, volume, expression, sustain, etc.)

• Registered/Non-Registered Parameter Number values (RPN/NRPN)

• MIDI Machine Control commands (MMC), such as Play, Stop, Pause, Rewind, etc.

• Bank/Program changes

• Channel aftertouch

 ♪: Not all devices can be configured to transmit every type of messages listed above.

Some Arturia devices do not have controller maps. Here is a partial list of devices that do or
don't:

• Controller maps: KeyLab series, MiniLab/MiniLab mk2, BeatStepPro

• No controller map: DrumBrute, MatrixBrute

5.1. Creating a Controller Map

The graphic of the device's front panel is used to assign the various types of MIDI data to
the individual controls.

Click on a control to select it. If it is assignable, it will turn red and its current assignments
will be shown at the bottom of the MCC window.

To edit the settings and ranges, use the pull-down menus and data entry knobs/fields as
described in the Overview chapter [p.4].

The options for each field will be different for each control type.

BeatStep Controller Map: Level/Rate
encoder selected

20 Arturia - User Manual MIDI Control Center - Controller Maps



 ♪: Some devices may not use standard MIDI controller assignments. Refer to the documentation for

your device to determine what settings to use for each purpose.

5.1.1. Assignable vs. non-assignable controls

If you click on a control and it does not turn red, then that control is not assignable.

For example, the left side of the BeatStep Pro front panel has entire sections of buttons and
knobs that are not assignable, such as the Project/Sequencer/Drum section selector buttons.

The picture below has been edited to indicate the assignable/non-assignable control areas
of the BeatStep Pro front panel:

The areas surrounded by green rectangles indicate that these controls are part of the
Controller Map and are MIDI-assignable. The other controls are not assignable, so they are
not part of the Controller Map.

5.1.2. Rear and side panel controls

There are also some devices with assignable controls on their side or rear panels. An
example of this would be the KeyLab series controllers:

In the picture above there are four selectable Control Inputs: three pedals and the Breath
Controller input, for a total of four MIDI-assignable control inputs on the rear panel alone.

The BeatStep Pro front panel

KeyLab Controller Map: Expression Pedal selected, Breath
Controller also available
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6. UPDATES

6.1. Device Firmware Upgrades

The MCC will notify you of firmware updates for the connected device if your computer is
connected to the internet. Firmware update notifications will look something like this:

 !: If the upgrade notification also appears in the middle of the MCC window, this means the firmware

update is an important one. The notification window will continue to appear whenever that device is

selected until the upgrade is performed.

Here is an example of what you will see in this case:

To update the firmware on your device, click the Install button and follow the prompts.

6.2. MIDI Control Center updates

When a new version of the MIDI Control Center becomes available, a pop-up window will
appear and ask you if you would like to update the software.

It's always a good idea to be as up-to-date as possible, but if updating is inconvenient at
that moment you can update the software the next time you start it.

Firmware update
notification

Essential firmware update notification
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7. TROUBLESHOOTING

7.1. Error messages

The MIDI Control Center may occasionally have trouble connecting to an attached device.
When this happens, it will display an error message to let you know there is a problem, and
it will also suggest a solution.

The following chart has a list of steps you can follow if you encounter an error message.

Error message Cause Solution

Device not

recognized
Connected to USB hub Disconnect/reconnect device at hub

Disconnect/reconnect hub

Disconnect device from hub, connect to

computer

Restart computer

Device failed to open
Device in use by other

application
1. Quit other application temporarily

2. Open the MCC, make needed edits

3. Quit the MCC, re-open other application

♪: The numbered solution steps should be performed in order.

7.2. Device not recognized

You may see this error message if your Arturia device is connected through a USB hub,
instead of directly connected to a USB port on your computer.

The solution for this may require one or more of the following steps:

• Disconnect the Arturia device and reconnect it to the hub,

• Disconnect the Arturia device from the hub and connect it directly to your
computer,

• Disconnect the hub from the computer and then reconnect it, or

• Restart your computer.

Device not recognized

Arturia - User Manual MIDI Control Center - TROUBLESHOOTING 23



7.3. Device failed to open (Windows only)

The following message may appear if your device is already being used by another
application such as a DAW or a standalone version of a software synthesizer.

The solution in this case is as follows:

1. Quit the other application

2. Launch the MIDI Control Center

3. Make the changes you would like to make on your device

4. Quit the MIDI Control Center, and

5. Restart the other application.

Device failed to open
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8. SOFTWARE LICENSE AGREEMENT

In consideration of payment of the Licensee fee, which is a portion of the price you paid,
Arturia, as Licensor, grants to you (hereinafter termed “Licensee”) a nonexclusive right to
use this copy of the SOFTWARE.

All intellectual property rights in the software belong to Arturia SA (hereinafter: “Arturia”).
Arturia permits you only to copy, download, install and use the software in accordance with
the terms and conditions of this Agreement.

The product contains product activation for protection against unlawful copying. The OEM
software can be used only following registration.

Internet access is required for the activation process. The terms and conditions for use of the
software by you, the end-user, appear below. By installing the software on your computer
you agree to these terms and conditions. Please read the following text carefully in its
entirety. If you do not approve these terms and conditions, you must not install this software.
In this event give the product back to where you have purchased it (including all written
material, the complete undamaged packing as well as the enclosed hardware) immediately
but at the latest within 30 days in return for a refund of the purchase price.

1. Software Ownership Arturia shall retain full and complete title to the SOFTWARE recorded
on the enclosed disks and all subsequent copies of the SOFTWARE, regardless of the media
or form on or in which the original disks or copies may exist. The License is not a sale of the
original SOFTWARE.

2. Grant of License Arturia grants you a non-exclusive license for the use of the software
according to the terms and conditions of this Agreement. You may not lease, loan or sub-
license the software. The use of the software within a network is illegal where there is the
possibility of a contemporaneous multiple use of the program.

You are entitled to prepare a backup copy of the software which will not be used for
purposes other than storage purposes.

You shall have no further right or interest to use the software other than the limited rights as
specified in this Agreement. Arturia reserves all rights not expressly granted.

3. Activation of the Software Arturia may use a compulsory activation of the software and
a compulsory registration of the OEM software for license control to protect the software
against unlawful copying. If you do not accept the terms and conditions of this Agreement,
the software will not work.

In such a case the product including the software may only be returned within 30 days
following acquisition of the product. Upon return a claim according to § 11 shall not apply.

4. Support, Upgrades and Updates after Product Registration You can only receive support,
upgrades and updates following the personal product registration. Support is provided only
for the current version and for the previous version during one year after publication of the
new version. Arturia can modify and partly or completely adjust the nature of the support
(hotline, forum on the website etc.), upgrades and updates at any time.

The product registration is possible during the activation process or at any time later through
the Internet. In such a process you are asked to agree to the storage and use of your
personal data (name, address, contact, email-address, and license data) for the purposes
specified above. Arturia may also forward these data to engaged third parties, in particular
distributors, for support purposes and for the verification of the upgrade or update right.

5. No Unbundling The software usually contains a variety of different files which in its
configuration ensure the complete functionality of the software. The software may be used
as one product only. It is not required that you use or install all components of the software.
You must not arrange components of the software in a new way and develop a modified
version of the software or a new product as a result. The configuration of the software may
not be modified for the purpose of distribution, assignment or resale.
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6. Assignment of Rights You may assign all your rights to use the software to another
person subject to the conditions that (a) you assign to this other person (i) this Agreement
and (ii) the software or hardware provided with the software, packed or preinstalled
thereon, including all copies, upgrades, updates, backup copies and previous versions,
which granted a right to an update or upgrade on this software, (b) you do not retain
upgrades, updates, backup copies und previous versions of this software and (c) the
recipient accepts the terms and conditions of this Agreement as well as other regulations
pursuant to which you acquired a valid software license.

A return of the product due to a failure to accept the terms and conditions of this Agreement,
e.g. the product activation, shall not be possible following the assignment of rights.

7. Upgrades and Updates You must have a valid license for the previous or more inferior
version of the software in order to be allowed to use an upgrade or update for the software.
Upon transferring this previous or more inferior version of the software to third parties the
right to use the upgrade or update of the software shall expire.

The acquisition of an upgrade or update does not in itself confer any right to use the
software.

The right of support for the previous or inferior version of the software expires upon the
installation of an upgrade or update.

8. Limited Warranty Arturia warrants that the disks on which the software is furnished is
free from defects in materials and workmanship under normal use for a period of thirty (30)
days from the date of purchase. Your receipt shall be evidence of the date of purchase. Any
implied warranties on the software are limited to thirty (30) days from the date of purchase.
Some states do not allow limitations on duration of an implied warranty, so the above
limitation may not apply to you. All programs and accompanying materials are provided “as
is” without warranty of any kind. The complete risk as to the quality and performance of the
programs is with you. Should the program prove defective, you assume the entire cost of all
necessary servicing, repair or correction.

9. Remedies Arturia's entire liability and your exclusive remedy shall be at Arturia's option
either (a) return of the purchase price or (b) replacement of the disk that does not meet the
Limited Warranty and which is returned to Arturia with a copy of your receipt. This limited
Warranty is void if failure of the software has resulted from accident, abuse, modification,
or misapplication. Any replacement software will be warranted for the remainder of the
original warranty period or thirty (30) days, whichever is longer.

10. No other Warranties The above warranties are in lieu of all other warranties, expressed
or implied, including but not limited to, the implied warranties of merchantability and fitness
for a particular purpose. No oral or written information or advice given by Arturia, its dealers,
distributors, agents or employees shall create a warranty or in any way increase the scope
of this limited warranty.

11. No Liability for Consequential Damages Neither Arturia nor anyone else involved in
the creation, production, or delivery of this product shall be liable for any direct, indirect,
consequential, or incidental damages arising out of the use of, or inability to use this product
(including without limitation, damages for loss of business profits, business interruption, loss
of business information and the like) even if Arturia was previously advised of the possibility
of such damages. Some states do not allow limitations on the length of an implied warranty
or the exclusion or limitation of incidental or consequential damages, so the above limitation
or exclusions may not apply to you. This warranty gives you specific legal rights, and you
may also have other rights which vary from state to state.
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